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EMPLOYABILITY SKILLS

CHAPTER 1: Communication Skills–I
Unsolved Questions
 Ans 1. The basic elements of a communication cycle are as follows:
 (i) Sender: This is the individual or entity who initiates the communication, 

intending to convey information or express their thoughts, emotions or ideas.
 (ii) Encoding: The sender’s role is to transform his thoughts or ideas into a format 

suitable for transmission and comprehension. This transformation may involve 
converting the message into spoken words, written text or non-verbal signals.

 (iii) Message: The message is the actual content that the sender wishes to 
communicate. This content can take various forms, including spoken words, 
written text or non-verbal cues.

 (iv) Channel: The channel is the medium through which the message is transmitted. 
It could be through speaking, writing or using gestures, among other methods.

 (v) Receiver: The receiver is the individual or entity at the other end of the 
communication. Their task is to receive the message and decode it, making 
sense of its meaning and context.

 (vi) Feedback: Feedback refers to the response given by the receiver to the sender. 
It can take the form of verbal or non-verbal signals. This feedback is vital 
because it enables the sender to evaluate the effectiveness of the communication 
and make adjustments, if necessary.

 Ans 2. Communication is the most important factor in various aspects of our lives, 
whether it involves relationships, work, education or personal development. Some 
key advantages of effective communication include the following:

 (i) Building and Sustaining Relationships: Communication is the fundamental 
basis of all kinds of human relationships—personal or professional. Effective 
communication helps in building and sustaining these relationships.

 (ii) Sharing Information: The ability to communicate is the primary means for exchanging 
information and knowledge. It is only through communication that we can share our 
thoughts, experiences and insights while learning from others in return.

 (iii) Problem-solving and Decision-making: Effective communication is essential for 
collaboration and teamwork. It aids in problem identification, exploring solutions 
and collectively making decisions through discussions and exchanging ideas.

 (iv) Conflict Resolution: Communication is an essential tool for resolving conflicts 
and disagreements. While it allows us to express our needs and viewpoints 
clearly, it also helps us to understand others’ perspectives. By actively listening 
to others, we can discover common ground and reach mutually acceptable 
solutions.

 (v) Personal Growth and Development: Communication also serves as a foundation 
for personal growth and self-expression. Through self-expression and meaningful 
conversations, we can nurture our own ideas, gain a deeper sense of self-
awareness and evolve as individuals.
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 Ans 3.
Verbal Communication Non-verbal Communication

This mode of communication relies on 
spoken words to transmit information. It 
is used for a wide range of interactions, 
including face-to-face conversations, 
telephone calls and public speaking. Some 
advantages of verbal communication 
are immediate feedback, non-verbal 
cues, personal connection and clarity. 
Example: public speaking, telephonic 
interview, etc. 

Non-verbal communication doesn’t rely 
on spoken words. Instead, it involves the 
use of body language, gestures, facial 
expressions and other non-verbal hints 
to convey information. Non-verbal hints 
play a significant role in adding meaning 
and context to non-verbal communication. 
Examples include crossed arms, smiling, 
fidgeting, etc.

 Ans 4. Some advantages of verbal communication are as follows:
 (i) Immediate Feedback: Verbal communication allows for instant feedback and 

response. This enables real-time conversations and allows for clarification of 
misunderstandings as they occur during the conversation.

 (ii) Non-verbal Cues: Verbal communication usually incorporates tone, manner 
and other non-verbal hints to complement the information being conveyed. 
These elements make it possible to additionally convey emotions and nuanced 
details that may not be expressed verbally.

 (iii) Personal Connection: Verbal communication plays a vital role in building 
personal relationships and developing a sense of connection between people. 
It allows for a more personal and human connection, as voice and presence 
add depth to interaction.

 (iv) Clarity: Verbal communication can be an effective way to ensure that 
everyone has a clear understanding of the information being conveyed. It 
allows for immediate clarification and questions, reducing the likelihood of 
misinterpretation.

  While verbal communication has its share of advantages, it is also accompanied 
by the following challenges:

 (i) Misunderstandings: Verbal communication can result in misunderstandings, 
especially when language/accents are involved. Differences in pronunciation, 
vocabulary or interpretation can lead to confusion between those conversing.

 (ii) Emotional Influence: Emotions can impact verbal communication, making it 
challenging to express oneself clearly and effectively. Emotions like anger, 
nervousness or excitement can interfere with the delivery of the intended message.

 (iii) Lack of Record: Unlike written communication, verbal exchanges are usually not 
recorded. This can be a drawback when it is necessary to have a documented 
record of what was discussed. Verbal agreements or important details might 
be forgotten or disputed.

 (iv) Distance Limitation: Verbal communication is limited by physical distance. 
It is generally only possible to communicate with individuals who are within 
hearing range, which can be a constraint in certain situations. However, this 
constraint has been overcome using technology where telecommunication and 
the internet have brought the world closer together.

 Ans 5. Here are some common forms of non-verbal communication:
 (i) Facial Expressions: Our face is highly expressive during any communication 

and can convey a wide range of emotions, such as happiness, sadness, anger 
and fear.
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 (ii) Eye Contact: Eye contact or the lack of it adds a lot of value in a conversation. 
The way a person looks at someone can communicate interest, attentiveness, 
confidence or even anger.

 (iii) Posture: How one holds oneself can convey various qualities, including 
confidence, dominance or submissiveness, as observed in body stance and 
gestures.

  Non-verbal communication, at times, complements verbal communication, especially 
when the information can be conveyed with a nod, tone of voice, eye contact or 
touch.

 Ans 6. Visual communication has the potential to have a significant impact on individuals 
across all levels of literacy. As visual communication makes use of visual aids, 
including images, graphics and videos, to transmit information and ideas, those 
who are not educated enough to gather information from the written text, can 
easily grasp what is being conveyed. It offers distinct advantages, including:

 (i) Accessibility: Visual communication can enhance accessibility, making 
information more comprehensible, especially for individuals with limited 
education.

 (ii) Engagement: Visual communication tends to be more engaging than other 
forms of communication since it appeals to people’s visual senses and can 
capture and sustain their attention more effectively.

 (iii) Memory: Visual communication has the advantage of being more memorable 
compared to other communication forms, as images and graphics are easy to 
remember and recall.

 (iv) Clarity: Visual communication serves as an effective method to clarify complex 
information and ideas by simplifying and breaking down the content into 
more manageable components.

 Ans 7. In communication, there are four primary types of sentences, each with its own 
purpose, as outlined below with examples. We may use these to express ourselves.

 (i) Declarative Sentences: Declarative sentences make statements or express 
ideas.

  Example: “The cat sleeps peacefully on the windowsill.”
 (ii) Imperative Sentences: Imperative sentences give commands or make requests.
  Example: “Please close the door quietly.”
 (iii) Interrogative Sentences: Interrogative sentences ask questions.
  Example: “Where are you going this evening?”
 (iv) Exclamatory Sentences: Exclamatory sentences express strong emotions or 

convey surprise. Example: “How incredible the fireworks display was!”

 Ans 8. Simple Sentence: A simple sentence consists of a single independent clause and is 
typically punctuated with a period (.) at the end.

  Example: “The sun sets in the west.”

  Compound Sentence: A compound sentence includes two or more independent 
clauses, joined by a coordinating conjunction (and, but, or, nor, for, yet, so). It is 
often punctuated with a comma (,) followed by a conjunction. Example: “The sun 
sets in the west, and the moon rises in the east.”

 Ans 9. A paragraph is a structured and meaningful unit of writing. It is correctly defined 
as “a logically cohesive group of sentences or text that centres around one main 
idea or topic and comprises one or more sentences that support or elaborate on 
that central concept.”
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  The essential components and purpose of a paragraph are:
  (i) Typically, a paragraph begins with a topic sentence that states the main idea 

and is followed by supporting sentences that provide details or examples.
  (ii) Paragraphs serve to organize written content and facilitate the comprehension 

of the logical flow of ideas within a written work.

 Ans 10. Some key guidelines for writing effective paragraphs are presented below:
  (i) Clear Topic: Always start the paragraph with a clear topic that introduces 

the primary idea and conveys the focus of the writing.
  (ii) Supporting Sentences: Subsequent sentences should offer details, examples 

and explanations that add value to the topic.
  (iii) Specific Details: It is always useful to provide specific details as they are 

more impactful than abstract or general information.
  (iv) Maintain Focus: Throughout the writing, it is important to sustain concentration 

on the main idea of the paragraph, ensuring that each sentence pertains to 
the topic.

  (v) Transitional Words and Phrases: Use transitional words and phrases to connect 
sentences and ideas within the paragraph, guiding the reader through the 
content.

  (vi) Sentence Length: To make the paragraph interesting to read and to enhance 
reader engagement, we may try writing sentences with a variety of length.

  (vii) Concluding Sentence: It is also worthwhile to conclude the paragraph with 
a sentence that provides closure and either summarizes the main idea or 
smoothly transitions to the next paragraph.

 Ans 11. The following table provides examples of how perspectives can affect communication. 
Recognizing and respecting these diverse perspectives is key to fostering effective 
communication and avoiding potential misinterpretations.

Perspective Effect on Communication
(i) Cultural differences Different cultural norms and values may lead to 

misinterpretations.
(ii) Emotional state Emotional states like happiness or sadness can affect 

how a message is received.
(iii) Beliefs and values Differing personal beliefs can lead to contrasting 

interpretations.
(iv) Biases Biases can influence how a message is perceived, 

potentially causing misunderstandings.
(v) Status and authority Variations in status or authority can impact the 

perceived importance of the message.
(vi) Expertise Differences in expertise may lead to variations in how 

the message is valued and understood.

  Perspectives can have a significant impact on communication as they influence 
how people perceive, interpret and respond to information. Diverse perspectives 
can lead to varying interpretations of the same message, potentially resulting in 
misunderstandings and miscommunication. It is important to understand and 
appreciate these perspectives because they are influenced by an individual’s life 
experiences, faith, culture, environment and numerous other factors. For instance, 
people may possess different norms, values and beliefs. They may also be influenced 
by biases or emotions, which can impact how they perceive and interpret a message.
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 Ans 12. The following are the 7Cs of effective communication:
  (i) Clarity: The message should be clear, concise and easily understood.
  (ii) Completeness: The message should contain all the necessary information, 

leaving out no crucial details.
  (iii) Conciseness: Keep the message brief and to the point, avoiding unnecessary 

details that may clutter the information.
  (iv) Correctness: Ensure that the message is accurate and free from errors or 

mistakes.
  (v) Concreteness: Make the message specific and concrete, supporting it with 

examples and details to reinforce its meaning.
  (vi) Consideration: Take into account the needs, interests and values of the 

audience when crafting the message.
  (vii) Courtesy: Communicate in a polite, respectful and considerate manner towards 

the audience.

  The following examples explain how the 7Cs of communication contribute to effective 
communication:

Perspective Effect on Communication
(i) Clarity “I need you to submit the homework by 1 pm on Friday.”

(ii) Completeness “Here’s the report you requested. It includes the data you 
asked for and my analysis of the results.”

(iii) Conciseness “Can we meet at 2 pm to discuss the assignments?”
(iv) Correctness “The budget for the project is 50,000, not 500,000.”
(v) Concreteness “The students’ performance increased by 10% in the last 

semester and we expect them to continue growing at the 
same rate next semester.”

(vi) Consideration “I know you’re busy with other assignments but I would 
really appreciate it if you could review this report and give 
me your feedback by Monday.”

(vii) Courtesy “I appreciate your hard work on this project. I have a few 
suggestions that I think could help us improve the final 
submission.

 Ans 13. A sentence consists of various essential components known as the parts of a 
sentence. The components which may be included in a sentence are presented 
below with examples:

 • Subject: The subject is the element of the sentence that focuses on a person, 
place, thing or idea.

  Example: ‘Hiral’ in “Hiral is painting a picture.”
 • Verb: The verb signifies the action or the state being carried out by the subject.
   Example: ‘is painting’ in “Hiral is painting a picture.”
 • Object: The object relates to the person, place, thing or concept upon which the 

action of the verb is performed or to which it pertains.
  Example: ‘a picture’ in “Hiral is painting a picture.”

 Ans 14. Phrases are used to enhance the meaning and clarity of sentences but are unable to 
function as complete sentences independently. They play a crucial role in providing 
context and details within a sentence structure. For example, the phrase “with a 
smile” describes someone’s manner but needs more context to make sense.
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  There are various types of phrases, including:
 • Noun Phrases: These phrases revolve around a noun and its associated words, 

providing more information about the noun.
 • Verb Phrases: Verb phrases encompass the verb and its related words, such as 

auxiliary verbs or adverbs, to convey the action in greater detail.
 • Adjective Phrases: Adjective phrases modify nouns or pronouns, offering 

descriptions or details about them.
 • Adverb Phrases: Adverb phrases modify verbs, adjectives or other adverbs, 

enhancing the meaning of the sentence.

 Ans 15. Here are some types of non-verbal communication and their significance in conveying 
information:

  (i) Facial Expressions: Our face is highly expressive during any communication 
and can convey a wide range of emotions, such as happiness, sadness, anger 
and fear.

  (ii) Eye Contact: Eye contact or the lack of it adds a lot of value in a conversation. 
The way a person looks at someone can communicate interest, attentiveness, 
confidence or even anger.

  (iii) Posture: How one holds oneself can convey various qualities, including 
confidence, dominance or submissiveness, as observed in body stance and 
gestures.

  (iv) Gestures: Hand movements, like pointing, waving or using thumbs-up or 
thumbs-down, convey different meanings based on context and cultural norms.

  (v) Touch: Physical contact, such as a handshake, hug or a pat on the back, can 
convey affection, respect or even aggression, depending on the context and 
the relationship between individuals.

  (vi) Physical Distance: The physical distance between people can communicate 
intimacy, comfort or hostility. Standing close to someone or maintaining a 
safe distance sends different signals.

  (vii) Tone of Voice: The way a person speaks, including volume, pitch and rhythm, 
can convey various emotions and attitudes, such as confidence, nervousness 
or anger.

 Ans 16. A compound-complex sentence features two or more independent clauses and one 
or more dependent clauses and is often punctuated with a combination of commas 
(,) and conjunctions (and, but, or, nor, for, yet, so). Example: “She sang beautifully, 
but her voice wavered when she reached the high note.”



CHAPTER 2: Self-Management Skills–I
Unsolved Questions
 Ans 1. Self-management means being in charge of your thoughts, feelings and actions to 

reach your goals. It also involves handling yourself in relation to others and the 
resources around you. This skill allows you to take charge of your life, set your 
priorities and make good choices.

  Some self-management skills are:
  (i) Time Management: Time management means using your time wisely to 

reach your goals. This includes deciding what is most important, making a 
schedule and saying a firm ‘NO’ to activities that waste time. A great way 
to manage your time is to make a list of things you need to do each day and 
then prioritize them based on their importance and when they are due.

  (ii) Goal-Setting: Goal-setting is about figuring out what you want to achieve and 
making a plan to get there. It keeps you on track and motivated by giving 
you a clear path and purpose. To set effective goals, use the SMART criteria, 
which means they should be Specific, Measurable, Achievable, Realistic and 
Time-bound.

  (iii) Decision-Making: Decision making involves evaluating options and choosing 
the best course of action. It is an essential skill for self-management because 
it helps you make good decisions that align with your values and goals.

  (iv) Problem-Solving: Problem-solving is about identifying problems, coming up 
with probable solutions and picking the best one. It is an important skill for 
self-management because it helps you tackle difficulties and roadblocks.

 Ans 2. Self-management is important because it keeps a person on track, organized 
and motivated. Without self-management, one might struggle to finish tasks on 
time. However, by developing self-management skills, anyone can increase their 
productivity, reduce stress levels and improve their overall well-being.

  Self-management can help achieve long-term goals if practised in everyday life, for 
example, by using their time and resources well, students can finish assignments 
on time and get better grades, which may help them in getting admission to good 
colleges/institutes, paving the way for a remarkable career for them. Similarly, 
self-managed professionals can set clear goals and make good choices that match 
their long-term plans.

  Besides, self-management lets people work on projects by themselves, without 
constant supervision. Self-management also helps you to understand what you are 
good at, where you need improvement and how you can grow.

 Ans 3. By encouraging students to follow the given guidelines, teachers and parents can 
help students to develop good self-management habits:

  (i) Time Management: Time management means using your time wisely to 
reach your goals. This includes deciding what is most important, making a 
schedule and saying a firm ‘NO’ to activities that waste time. A great way 
to manage your time is to make a list of things you need to do each day and 
then prioritize them based on their importance and when they are due.

  (ii) Goal-Setting: Goal-setting is about figuring out what you want to achieve and 
making a plan to get there. It keeps you on track and motivated by giving 
you a clear path and purpose. To set effective goals, use the SMART criteria, 
which means they should be Specific, Measurable, Achievable, Realistic and 
Time-bound.

  (iii) Decision-Making: Decision making involves evaluating options and choosing 
the best course of action. It is an essential skill for self-management because 
it helps you make good decisions that align with your values and goals.
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  (iv) Problem-Solving: Problem-solving is about identifying problems, coming up 
with probable solutions and picking the best one. It is an important skill for 
self-management because it helps you tackle difficulties and roadblocks.

 Ans 4. Self-awareness is the ability to recognize and understand one’s thoughts, emotions 
and behaviours and how they impact oneself and others. It involves being aware 
of one’s strengths, weaknesses and limitations, as well as one’s values and beliefs.

  Self-awareness is important because knowing yourself is a skill that can help you 
grow, get better and have better relationships with people. To be self-aware, you 
need to be open to thinking about yourself honestly and without being too critical. 
You also have to think about how others see you. It can involve practices such as 
writing a journal, being mindful and asking people you trust for their thoughts 
and feedback.

  “Your vision will become clear only when you can look into your own heart. Who 
looks outside, dreams; who looks inside, awakes.” —C.G. Jung

 Ans 5. Self-awareness comes in two forms: internal and external.
 • Internal self-awareness is about knowing your values, beliefs, emotions and why 

you do things.
 • External self-awareness is about knowing how others see you and how your 

actions affect them.

 Ans 6. Self-awareness is the ability to recognize and understand one’s thoughts, emotions 
and behaviours and how they impact oneself and others. It involves being aware 
of one’s strengths, weaknesses and limitations, as well as one’s values and beliefs.

  Being self-aware is a skill that can help you grow and have better relationships 
with people. For a self-aware student, it will help them have better relationships 
with other students as well as family members, friends and acquaintances.

 Ans 7. Stress is a natural reaction to challenging or threatening situations. While a bit 
of stress can be helpful, too much stress can harm students’ physical and mental 
health.

  Negative Stress (Distress): Long-lasting or severe stress that feels like it is too 
much to handle and can harm your physical and mental health.

  • Higher chance of heart problems
  A weaker immune system
  Issues with your stomach and digestion
  • Feelings of anxiety, depression, helplessness and hopelessness
  Increased irritability and anger
  Decreased self-esteem

 Ans 8. Stress management refers to the ability to cope with stress and reduce its negative 
impact. Stress management is another crucial part of self-management.

  Some common stress management techniques and their impact on us are presented 
in the table below:

Stress Management 
Techniques

Their impact

(i) Deep Breathing Inhaling and exhaling slowly and deeply to calm 
the mind and reduce physical tension
• Lowers heart rate
• Reduces muscle tension
• Improves focus and concentration
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(ii) Exercise Engaging in physical activities such as yoga, 
walking, playing favourite sports, swimming, 
dancing, etc.
• Improves overall physical health and well-being
• Reduces tension
• Promotes better sleep

(iii) Mindfulness & Meditation Focusing on the present moment and acknowledging 
thoughts and emotions without judgment
• Reduces anxiety and depression
• Improves sleep quality
• Increases self-awareness

(iv) Social Support Connecting with others and seeking emotional 
support from friends, family or mental health 
professionals
• Reduces feelings of loneliness and isolation
• Provides a sense of community
• Promotes healthy coping mechanisms

(v) Time Management Organizing and prioritizing tasks, setting 
realistic goals and managing time effectively
• Increases productivity
• Promotes a sense of accomplishment
• Increases a sense of control

(vi) Journaling/Diary Writing down thoughts and emotions to increase 
self-awareness and release negative feelings
• Improves self-awareness
• Reduces anxiety and depression
• Promotes emotional regulation

(vii) Relaxation Techniques Engaging in activities such as listening to music 
or spending time in nature to promote relaxation 
and reduce stress
• Reduces physical tension
• Promotes relaxation
• Improves mood and overall well-being

(viii) Sleep Routine Developing healthy sleep habits such as sticking 
to a regular sleep schedule in a relaxing sleep 
environment
• Improves sleep quality
• Reduces anxiety and depression
• Promotes overall physical and mental health

 Ans 9. Stress is a natural reaction to challenging or threatening situations. While a bit of 
stress can be helpful, too much stress can harm one’s physical and mental health 
affecting performance at work or in school.

  Self-management techniques, such as exercise, time management, journaling/
writing diary, relaxation techniques, sleep routine, go a long way in overcoming 
the impact of stress.

 Ans 10. Positive thinking is a way of thinking in which you concentrate on the good parts 
of situations and experiences and don’t give much attention to the negative parts. 
It is about having a mindset that sees opportunities and chances in each situation, 
rather than getting stuck on failures, problems or things that didn’t work out.

  Positive thinking brings many benefits, including greater self-confidence, less stress, 
improved physical health and better relationships. It is a key part of your journey 
to self-improvement.
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 Ans 11. Self-confidence is your own belief in your abilities and skills. It is a big part of 
self-management because it keeps you feeling motivated and focused on your goals. 
Self-confidence can also help you deal with tough situations and challenges by 
giving you a sense of determination.

  Positive thinking is a way of thinking in which you concentrate on the good parts 
of situations and experiences and don’t give much attention to the negative parts. 
It is about having a mindset that sees opportunities and chances in each situation, 
rather than getting stuck on failures, problems or things that didn’t work out.

  Positive thinking helps in challenging negative thoughts, paying attention to 
negative self-talk and countering it with positive and empowering thoughts. 
Positive thinking brings many benefits, including greater self-confidence, less 
stress, improved physical health and better relationships. It is a key part of your 
journey to self-improvement.

 Ans 12. Personal hygiene refers to the practices that we undertake to maintain cleanliness 
and promote good health. Personal hygiene is a crucial aspect of our lives and it is 
important to learn the basics of hygiene from an early age. Maintaining personal 
hygiene is an important part of taking care of your health and well-being.

 Ans 13. Personal hygiene refers to the practices that we undertake to maintain cleanliness 
and promote good health. Personal hygiene is a crucial aspect of our lives and it is 
important to learn the basics of hygiene from an early age. Maintaining personal 
hygiene is an important part of taking care of your health and well-being.

  The following are some good personal hygiene practices:
  (i) Taking a shower or bathing each day removes dirt, sweat and bacteria from 

your skin, preventing body odour.
  (ii) Brushing your teeth twice daily and flossing once a day removes food bits 

and plaque, which can cause tooth decay, bad breath and gum issues.
  (iii) Daily washing your face helps get rid of dirt, oil and makeup that can block 

pores and cause acne or other skin troubles.
  (iv) Regularly washing your hands with soap and water stops germs from spreading 

and lowers the risk of getting sick.
  (v) Keeping your nails short helps prevent dirt and bacteria from gathering 

underneath, which can lead to infections.

 Ans 14. Teachers and parents can go a long way in inculcating in students the habit of 
maintaining personal hygiene. Some examples are:

  At home, parents can ensure that their child brushing his teeth, taking a bath 
daily and washing his hands after playing and before having their meal and keep 
their surroundings clean.

  In school, teachers can discuss the benefits of keeping oneself clean, washing hands 
to prevent diseases, citing communicable diseases like COVID-19 as an example, 
to stay healthy. Another step that teachers can take to ensure that the students 
are conscious about personal hygiene is checking their nails randomly.



CHAPTER 3: ICT Skills–I
Unsolved Questions
 Ans 1. 

Input Device Output Device Storage Device
Microphone Plotter Flash Drive
Touch screen Speaker Hard disk
Bar Code reader Printer
Light Pen Projector

 Ans 2. (a) RAM (Random-Access Memory): RAM is volatile in nature and hence holds 
the data till the computer is switched on.

   The data to be worked upon is brought into primary memory or RAM.
   ROM (Read-Only Memory): ROM is permanent in nature as its contents are 

retained even after the system gets switched off.
   Some preliminary steps for booting process, i.e., startup or warm-up session, 

resides in ROM and are read from the ROM.
  (b) Plotter: Plotters are the output devices that are used for producing vector 

graphics, good-quality images and drawings like architectural designs, maps, 
computer-aided designing (CAD), etc., by plotting lines using a pen. Unlike 
printers, they support printing of large-sized papers. The pens in plotters use 
different-colored ink to draw in different colors.

   Printer: A printer is an output device which is used to generate hard copies 
(printout) of the output generated by the computer system. The printer can 
generate both text and images on paper.

  (c) Web Page: A web page is an electronic document/page designed using HTML. It 
displays information in textual or graphical form. Traversal from one web page 
to another is possible through hyperlinks. The first page of a website is called 
home page. It generally contains information and links of all the related web 
pages. Each web page has a unique address that is visible on the address bar.

   Website: A website is a collection of various web pages, images, video, audio and 
other kinds of digital assets that are hosted on one or several web servers. The 
first page of a website is known as home page where all the links related to other 
documents are displayed. The web pages of a website are written using HTML 
and the information is transferred over the internet through the HTTP protocol. 
HTML documents consist of several hyperlinks that are accessed through the 
HTTP protocol. Examples of various websites are cbse.nic.in, google.com, amazon.
in, etc.

 Ans 3. ICT stands for Information and Communication Technology. The world around us 
revolves around computers and it has become an indispensable part of our life. ICT 
skills have made our lives better and easier as it helps us in doing our day-to-day 
tasks flawlessly, efficiently and quickly. The best examples are smartphones that 
have become the most important and indispensable hand-held devices.

  The following are the areas where ICT is being used:

  Role of ICT in Personal Life:
  (a) Online Financial Services
  (b) Communication
  (c) Healthcare
  (d) Education
  (e) Entertainment
  (f) Social Networking Platforms
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  Role of ICT in Industries and Businesses:
  (a) Banking Industry
  (b) E-commerce
  (c) Accounting Tools
  (d) Training and Education
  (e) Travel and Ticketing
  (f) Research
  (g) Defence

 Ans 4. A light pen is a pointing device that can be used to select anything on the computer 
screen by simply pointing at it or for drawing figures directly on the screen. The 
tip of the light pen, termed as stylus, contains a light-sensitive element which, 
when placed on the screen, detects light from the screen, enabling the computer to 
identify the location of the pen on the screen. Clicking is performed by pressing the 
pen on the screen. A light pen is mostly used by engineers, architects or designers.

 Ans 5. Laser printers use laser technology to produce printed documents. They work just 
like a photocopy machine and print good-quality images at high speed.

  Laser printers are used both in offices and homes. Color laser printers too produce 
very good result.

 Ans 6. (a) ALU: Arithmetic Logic Unit
  (b) CU: Control Unit
  (c) CPU: Central Processing Unit

 Ans 7. Central Processing Unit (CPU): A computer receives data and instructions through 
input devices which get processed by the CPU and the result is shown through 
the output devices. The main/primary memory and secondary/auxiliary memory 
are used to store data inside the computer.

  The CPU is the control centre/brain of a computer. It guides, directs, controls and 
governs all the processing that takes place inside the computer.

 Ans 8. Email (Electronic mail): Short for electronic mail, e-mail or email is the information 
stored on a computer that is exchanged between people over a network. It is a 
fast and efficient way to communicate with multiple users at the same time and 
is the cheapest and fastest method to send files that may contain text, images 
and other information across the network.

  Postal mail, as we all know, is slow as compared to electronic mail. Thus, matters 
of urgency cannot be left to postal mail. However, sending parcels, etc, is not 
possible through electronic mail, where postal mail comes in handy.

 Ans 9. Web browser is a software that helps in accessing web pages and thus, is also 
called web client. It helps the user to navigate through the world wide web and 
displays web pages. Some popular web browsers are Google Chrome, Mozilla 
Firefox, Opera, AOL, WebKit, etc.

  The site to be searched is done by typing the address of the web page (URL) in the 
address bar. Clicking on Go or pressing Enter from the keyboard shall take you to 
the destined website and the home page will be loaded on your browser window.

 Ans 10. The role of ICT at home:
  (a) Online Financial Services: One of the most sought-after services provided by ICT 

is online financial transactions. You can pay your bills online from the comfort of 
your home, without standing and waiting in long queues. Banking transactions 
are all done online using smartphones and computers. In addition to this, loan 
services, insurance and social welfare schemes can be accessed online.
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  (b) Communication: Sending and receiving messages with the click of a mouse 
has become easy and instant whether it is about updating meeting timings, 
communicating via email in offices, looking for information online, doing research 
work or seeking help and consultation. Sharing and collaborating information 
with each other through online mode has become faster and easier with time.

 Ans 11. ICT plays a significant role in industrial set-ups and businesses as described below:
  (i) Banking Industry: With e-banking, it is no longer required to wait in queues. 

You can do all banking transactions online now. Even new accounts can be 
opened online.

  (ii) E-commerce: With e-commerce, all types of business transactions are carried 
out very easily, accurately and by ensuring proper sales and services. Buying 
and selling of products through online mode has become very convenient.

  (iii) Accounting Tools: Handling of accounts is easily done through customized 
accounting tools that run on computers, which are required for business and 
personal purposes.

  (iv) Training and Education: Computers play significant roles in providing 
professional trainings, skill development, capacity-building programs, organizing 
workshops and online training sessions at school and college levels. Online 
tutorials, digitized content, e-libraries, multimedia tablets and user-friendly 
learning platforms have changed the face of education.

  (v) Travel and Ticketing: The IRCTC/Indian Railways portal is one of the most 
popular applications for booking online tickets, thanks to easy access through 
the internet, secured payments and instant services. Besides booking air 
tickets, hotel reservations and cab booking are just a click away.

 Ans 12. A computer is an electronic device that takes input in the form of data and 
generates output in the form of information. This process of converting data into 
some meaningful information is called Information Processing Output cycle or IPO 
cycle. This is performed by the fundamental units or the basic components of a 
computer system.

  Basic Operations of a Computer
  Every task given to a computer follows an Input → Process → Output Cycle (IPO 

cycle). 

Process

Storage

InformationData
Input Output

IPO Cycle

  It accepts certain input (raw data), processes that input and produces the desired 
output (processed data or information). 

  The input unit takes the input, the Central Processing Unit (CPU) processes the 
data and the output unit produces the output. The memory unit holds the data 
and instructions during the processing.

  A computer receives data and instructions through input devices which get processed 
by the CPU and the result is shown through the output devices. The main/primary 
memory and secondary/auxiliary memory are used to store data inside the computer, 
as shown in the given figure.
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  The main memory holds the input and intermediate output during the processing.

  

Control Unit (CU)

Main/Primary Memory Secondary Memory

Output Unit
Input Unit

Registers

Arithmetic Logic 
Unit (ALU)

CPU (Central Processing Unit)

    Functional Components of a Computer System

 Ans 13. Output Devices: Output devices are the physical components that produce the 
output or processed data generated by the computer system in human readable 
form. Some of the most commonly used output devices are speakers, monitor, 
printer, etc.

  Input Device: The input unit comprises devices attached to the computer. These 
devices help to provide instructions to the computer. Thus, it accepts input from 
the user and converts it into a form that can be understood by the computer  
(i.e., binary code/form). The term “Binary” means two states—ON/OFF or HIGH/
LOW—voltage and, in turn, two bits or symbols, 1 for ON and 0 for OFF. Examples 
include keyboard, light pen, etc.

 Ans 14. To turn off the computer completely, follow the given steps:
  (i) Click the Start button.
  (ii) Then, from the pop-up menu, click on Shut Down option. The computer 

desktop will disappear and the computer will gradually shut down.

 Ans 15. An email address is a unique identifier for an email account. It is used for 
both sending and receiving email messages. Every email address has two main 
parts—a username and a domain name. The username comes before ‘@’ and the 
domain name comes after it. In the example given, ‘abc’ is the username and  
‘gmail.com’ is the domain name: abc@gmail.com



CHAPTER 4: Entrepreneurial Skills-I

Unsolved Questions

 Ans 1. The different types of businesses are:
  (i) Manufacturing Business: A manufacturing business is a kind of business that 

deals with the production of goods (make things/products) in a step-by-step 
approach using raw materials, labour, technology, capital and production 
overheads. The entire process leads to finished goods which are then sold to 
the consumers directly or indirectly through wholesalers and retailers.

  (ii) Service Industry: Service industry serves consumers with intangible products 
(products without physical form) or benefits. These business establishments 
offer consultation, accounting, professional expertise, skills, hospitality and 
more.

  (iii) Merchandising Business: Merchandising is the most common form of business 
where products are purchased and sold in bulk which is beneficial to all—
wholesalers, retailers, shopkeepers and customers. In merchandising, finished 
products are purchased at wholesale price and sold to consumers at retail 
price.

  (iv) Hybrid Business: Hybrid business is a combination of the above business types, 
like service, manufacturing, merchandising or a combination of all three. It 
deals in both goods and services. The best example of a hybrid business is 
‘Patanjali Yogram’.

 Ans 2. Entrepreneurship Development is the process of improving and enhancing the 
required skillset and knowledge of an entrepreneur with respect to starting and 
running an enterprise and generating maximum profit while taking into account 
the risks involved. This can be structured in-house trainings, classroom training 
programs and sessions which will help budding entrepreneurs to become successful.

  Entrepreneurship development becomes necessary to tackle the problem of 
unemployment, to overcome stagnation in the economy and to give a boost to 
business and industries. It is a tool for industrialization.

 Ans 3. On a broader perspective, a business can be divided into corporate or non-
corporate form.

  

FORMS OF BUSINESS OWNERSHIP

CORPORATE NON-CORPORATE

Sole Proprietorship

Joint Hindu Family Business

Partnership Firm

Corporation/Joint Stock Company

Limited Liability Corporation

Cooperative
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 Ans 4. To become a successful entrepreneur, the following characteristics should be imbibed:
  (i) Risk-bearing Capacity: Every business, whether small or big, involves risks 

to a certain extent. Thus, an entrepreneur should have enough courage to 
take risks while setting up a new venture and take calculative decisions to 
capture the market and succeed.

  (ii) Innovation: Entrepreneurship involves coming out with innovative ideas for 
setting up a new business with a creative blend to changes in the environment 
and market requirement. It involves introduction of services and products in 
a new, better and innovative way.

  (iii) Purposeful and Goal-oriented: Entrepreneurship is a purposeful and goal-
oriented activity with a strong vision of earning maximum profits through 
innovative practices and eventually benefiting the society.

  (iv) Leadership Qualities: Entrepreneurship is all about managing a team with an 
intent to earn good profits. A successful entrepreneur should possess strong 
leadership qualities so that those working under their guidance strongly 
believe in them and respect them.

  (v) Flexible and Dynamic Process: Business is a dynamic activity that keeps 
on changing with respect to circumstances and market environment. Those 
changes create opportunities for entrepreneurs. So, a successful entrepreneur 
should be flexible and prepared in all situations and circumstances to work 
for the benefit of the business and society.

  (vi) Gap-filling Activity: An entrepreneur identifies and fills the gap between the 
requirement of society and what is available.

  (vii) Awareness about Market Trends: An entrepreneur fills the gap between what 
are the customers’ needs and what is available to them. The entrepreneur 
should be aware of a product’s market value and demand so that they can 
take better decisions and constantly improve their products based on customer 
feedback.

  (viii) Multi-dimensional: A multi-dimensional approach helps to improve the 
performance of an enterprise by taking care of all the important aspects related 
to it, viz. economic, psychological, social, cultural, etc. All these dimensions 
impact each other and eventually the growth of the business.

 Ans 5. The following are the roles of entrepreneurship:
  (i) Economic Development: An entrepreneur acts as one of the pillars of economic 

development through efficient use of resources and arranging capital for 
fruitful long-term investments.

  (ii) Generating Employment Opportunities: An entrepreneur efficiently utilizes 
human resources as they are job creators and not job seekers.

  (iii) Contribution towards Industrial Development: An entrepreneur contributes 
significantly towards industrial development by setting up new business ventures 
and industrial units in backward and rural areas to bring balanced regional 
development.

  (iv) Mobilizing Revenue: Entrepreneurs significantly help in increasing national 
wealth by mobilizing the revenue of a country.

  (v) Enhancing Standard of Living: As more businesses are set up, the problem of 
unemployment gets resolved to a great extent.



Book-IX 17

  The following are the rewards of entrepreneurship:
  (i) Independence: An entrepreneur is their own boss and takes independent decisions 

in terms of hours of work, team members, etc.
  (ii) Passion: Entrepreneurs are passionate about their dreams. As a job is performed 

with utmost sincerity and efforts, the results are also fruitful.
  (iii) Adventure and Excitement: There are numerous people who have given up their 

good jobs to nurture their dreams. They live up to their dreams and become 
successful entrepreneurs.

  (iv) Freedom: Entrepreneurship allows the freedom to implement one’s ideas as per 
their area of interest and perspective.

  (v) Profit-making and Financial Stability: Successful entrepreneurs create and 
maintain a good bank balance for themselves and benefit their employees and 
staff.

  (vi) Good Status: Success in entrepreneurship brings considerable fame and prestige.

 Ans 6. The abilities of a successful entrepreneur are:
  (i) Risk-bearing Capacity: Every business, whether small or big, involves risks 

to a certain extent. Thus, an entrepreneur should have enough courage to 
take risks while setting up a new venture and take calculative decisions to 
capture the market and succeed.

  (ii) Innovation: Entrepreneurship involves coming out with innovative ideas for 
setting up a new business with a creative blend to changes in the environment 
and market requirement. It involves the introduction of services and products 
in a new, better and innovative way.

  (iii) Purposeful and Goal-oriented: Entrepreneurship is a purposeful and goal-
oriented activity with a strong vision of earning maximum profits through 
innovative practices and eventually benefiting the society.

  (iv) Leadership Qualities: Entrepreneurship is all about managing a team with an 
intent to earn good profits. A successful entrepreneur should possess strong 
leadership qualities so that those working under their guidance strongly 
believe in them and respect them.

  (v) Flexible and Dynamic Process: Business is a dynamic activity that keeps 
on changing with respect to circumstances and market environment. Those 
changes create opportunities for entrepreneurs. So, a successful entrepreneur 
should be flexible and prepared in all situations and circumstances to work 
for the benefit of the business and society.

  (vi) Gap-filling Activity: An entrepreneur identifies and fills the gap between the 
requirement of society and what is available.

  (vii) Awareness about Market Trends: An entrepreneur fills the gap between what 
are the customers’ needs and what is available to them. The entrepreneur 
should be aware of a product’s market value and demand so that they can 
take better decisions and constantly improve their products based on customer 
feedback.

  (viii) Multi-dimensional: A multi-dimensional approach helps to improve the 
performance of an enterprise by taking care of all the important aspects related 
to it, viz. economic, psychological, social, cultural, etc. All these dimensions 
impact each other and eventually the growth of the business.
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 Ans 7. The three types of business activities are as follows:
  (i) Manufacturing Business: A manufacturing business is a kind of business that 

deals with the production of goods (make things/products) in a step-by-step 
approach using raw materials, labour, technology, capital and production 
overheads. The entire process leads to finished goods which are then sold to 
the consumers directly or indirectly through wholesalers and retailers.

  (ii) Service Industry: Service industry serves consumers with intangible products 
(products without physical form) or benefits. These business establishments 
offer consultation, accounting, professional expertise, skills, hospitality and 
more.

  (iii) Merchandising Business: Merchandising is the most common form of business 
where products are purchased and sold in bulk which is beneficial to all—
wholesalers, retailers, shopkeepers and customers. In merchandising, finished 
products are purchased at wholesale price and sold to consumers at retail 
price.

 Ans 8. Atal Innovation Mission, Startup India, Mudra Yojana Scheme and Entrepreneurship-
cum-Skill Development Programme (E-SDP) are some of the entrepreneurship 
development initiatives undertaken by the Government of India.

 Ans 9. Business includes all those economic activities that comprise exchange, purchase, 
sale, production/creation of goods and services with the objective of making 
profits along with customer satisfaction. A factory, a shop, a transport company, 
an insurance company, a commercial bank, an advertising agency, etc., are all 
examples of business enterprises. Hence, business may be defined as an economic 
activity involving the production and sale of goods and services to earn profits 
after satisfying consumer needs.

  On the contrary, Entrepreneurship is the process of discovering an opportunity, 
mobilizing resources and creating an establishment to exploit the opportunity. It is 
an attempt to create value. Business and entrepreneurship are both inter-related 
activities and cannot be separated.

 Ans 10. The following is the role of an entrepreneur in a country’s economic development:
  (i) Resources and Capital: An entrepreneur acts as one of the pillars of economic 

development through efficient use of resources and arranging capital for 
fruitful long-term investments.

  (ii) Generating Employment Opportunities: An entrepreneur efficiently utilizes 
human resources as they are job creators and not job seekers.

  (iii) Industrial Development: An entrepreneur contributes significantly towards 
industrial development by setting up new business ventures and industrial 
units in backward and rural areas to bring balanced regional development.

  (iv) Mobilizing Revenue: Entrepreneurs significantly help in increasing national 
wealth by mobilizing the revenue of a country.

  (v) Enhancing Standard of Living: As more businesses are set up, the problem 
of unemployment gets resolved to a great extent.



CHAPTER 5: Green Skills–I

Unsolved Questions
 Ans 1. In broader terms, ‘Environment’ means ‘surroundings’ (environs). The word 

‘environment’ has been derived from the French word ‘Environia’, which means ‘to 
surround’. Hence, environment refers to our surroundings which consist of biotic 
(living) and abiotic (non-living) components.

 Ans 2. Biotic: The living components of an ecosystem are called biotic components. 
Some of these include plants, animals as well as fungi and bacteria. Plants are 
autotrophs—they make their own food by absorbing carbon dioxide from the 
environment and releasing oxygen after the process of photosynthesis. Animals 
are mainly dependent on plants or on other animals for their food and existence.

  Abiotic: Abiotic components constitute all non-living components of an ecosystem. 
It includes air, water, soil, minerals, sunlight, temperature, nutrients, etc.

 Ans 3. Society and environment are interdependent. A society is a group of people 
living together in a community, sharing common interests and engaging in social 
interactions. Environmental changes, such as climate and weather, affect our 
lives. Conversely, our actions and activities impact the environment. For example, 
deforestation has led to soil erosion and changes in climatic conditions. Therefore, 
we can say that society and environment are interdependent and impact each other 
in equal measure.

 Ans 4. The various factors causing ecological imbalance are:
 • Deforestation: It is the outcome of population explosion. Due to rising population, 

forests and related ecosystems are cleared for urbanization and industrialization. 
This has resulted in land degradation and soil erosion and, in turn, has resulted 
in the extinction of many bird and animal species.

 • Pollution: It is defined as the contamination of environment, mainly air, water 
and soil, with undesirable addition of unwanted harmful substances or toxins 
that destroy the health of the environment and make it unfit and unhealthy 
for life sustenance and have long-lasting effects.

 • Global Warming and Greenhouse Effects: The increase in carbon dioxide 
content in the atmosphere due to emission of chlorofluorocarbons and other 
air pollutants, excessive use of fossil fuels like coal, petrol, oil and natural gas 
produces greenhouse gases like methane, carbon dioxide etc., and results in a 
sharp increase in greenhouse effect and, in turn, global warming.

 • Mining: It is the process of extracting minerals from the earth’s surface. If we 
will keep extracting minerals at the current pace, it will lead to their depletion 
and create an ecological imbalance. Large-scale mining leads to long-term effects 
such as land erosion, dust contaminating the air and improper mining waste 
disposal.

 • Radioactive and E-Waste: The working of nuclear reactors produces a lot of 
radioactive waste which is highly dangerous for all living beings. It is not 
decomposed and stays intact for thousands of years. Thus, radioactive waste 
should be handled properly. Another waste of concern is e-waste. This is due 
to large scale usage of smartphones, laptops and other digital gadgets which 
generate a lot of e-waste and need proper management.
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 Ans 5. An ecosystem is an interdependent community of living and non-living organisms 
that interact with each other and create a balance in their surrounding environment. 
For example, gardens, ponds and forests are all ecosystems. Any imbalance created 
in any of the components shall disturb the entire ecosystem, which may hamper 
the existence of other living organisms.

  An ecosystem comprises two major components:
 • Biotic: The living components of an ecosystem are called biotic components. Some 

of these include plants, animals as well as fungi and bacteria.
 • Abiotic: Abiotic components constitute all non-living components of an ecosystem. 

It includes air, water, soil, minerals, sunlight, temperature, nutrients, etc.

 Ans 6. Human activities have contributed to creating ecological imbalance in the following 
ways:

  (i) Deforestation: It is the outcome of population explosion. Due to rising 
population, forests and related ecosystems are cleared for urbanization and 
industrialization. This has resulted in land degradation and soil erosion and, 
in turn, has resulted in the extinction of many bird and animal species.

  (ii) Pollution: It is defined as the contamination of environment, mainly air, 
water and soil, with undesirable addition of unwanted harmful substances 
or toxins that destroy the health of the environment and make it unfit and 
unhealthy for life sustenance and have long-lasting effects.

  (iii) Global Warming and Greenhouse Effects: The increase in carbon dioxide 
content in the atmosphere due to emission of chlorofluorocarbons and other 
air pollutants, excessive use of fossil fuels like coal, petrol, oil and natural 
gas produces greenhouse gases like methane, carbon dioxide etc., and results 
in a sharp increase in greenhouse effect and, in turn, global warming.

  (iv) Mining: It is the process of extracting minerals from the earth’s surface. If 
we will keep extracting minerals at the current pace, it will lead to their 
depletion and create an ecological imbalance. Large-scale mining leads to long-
term effects such as land erosion, dust contaminating the air and improper 
mining waste disposal.

  (v) Radioactive and E-Waste: The working of nuclear reactors produces a lot of 
radioactive waste which is highly dangerous for all living beings. It is not 
decomposed and stays intact for thousands of years. Thus, radioactive waste 
should be handled properly. Another waste of concern is e-waste. This is due 
to large scale usage of smartphones, laptops and other digital gadgets which 
generate a lot of e-waste and need proper management.

 Ans 7. Green economy is described as an economy with low carbon emissions, less pollution, 
efficient use of resources and a healthy society. It can be achieved through clean 
energy to implement green initiatives.

  Building green economy can be achieved by inculcating green skills and environment-
friendly practices that require technical skills, knowledge, critical thinking and a 
problem-solving approach.

  Examples of green economy are renewable energy, sustainable agriculture, public 
transportation, etc.

  The important components of Green Economy are:
 • Renewable energy: Renewable energy is a form of energy which is produced by 

renewable resources like wind, sunlight, water, geothermal heat, etc. Using 
these alternative green energy sources contributes to lowering the impact on 
the environment caused by the depletion of non-renewable sources of energy.
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 • Green building and green transportation: This includes the construction of buildings 
and developing a well-planned transportation system with minimum damage to 
the environment and forests. Green transportation ensures the use of fuel that 
produces minimum greenhouse gases and pooling, promoting alternative sources 
of energy and fuel like CNG, battery, etc. Green transportation lowers dependency 
on fossil fuels, is cheaper and helps in keeping the environment clean.

 • Waste management: It means managing waste by following 4R’s—Refuse, Reduce, 
Reuse and Recycle—and 1U—Upcycle—for minimal environment degradation.

 • Land management: It relates to using land as a resource judiciously in terms of 
soil, forests and trees, farms, roads, etc., without causing harm to the environment.

 • Water management: Water management means to reduce water wastage and 
replenish groundwater level by adopting rainwater harvesting mechanism for future 
use. Using rainwater for agriculture and wastewater for washing and cleaning 
purposes proves to be an effective mechanism for reducing water wastage which 
is responsible for the scarcity of water.

 Ans 8. The need to develop green economy arises from the fact that it will help in conserving 
resources for future generations with improved social well-being and reduced 
environmental risks that will promote economic growth of a country, eradicate poverty 
and reduce carbon emissions and ecosystem degradation; In a green economy, growth 
in employment and income are driven by public and private investment into such 
economic activities, infrastructure and assets that allow reduced carbon emissions 
and pollution.

 Ans 9. Green buildings refer to the construction of buildings and developing a well-planned 
transportation system with minimum damage to the environment and forests.

  Green buildings support green economy by contributing effectively in the following 
areas:

 • Wastewater treatment
 • Using renewable energy (solar power and wind energy)
 • Rainwater harvesting
 • Use of clean energy and focusing on conserving energy
 • Reducing all types of pollution, mainly air, water and soil

 Ans 10. Air pollution is one of the most pressing environmental issues of our time. It not 
only affects the environment but also has a significant impact on human health. 
In recent years, there has been a growing awareness of the role of technology in 
reducing air pollution, which include:

 • Renewable energy sources like solar, wind and hydro power—they can significantly 
help to reduce the amount of pollution generated by traditional power plants.

 • Electric vehicles—they produce significantly less air pollution than traditional 
cars running on gasoline or diesel.

 • Air quality sensors—these devices measure the levels of pollutants in the air 
and can help identify areas with high levels of pollution, allowing authorities 
to take action to reduce pollution levels.

 • Air quality maps—they provide a visual representation of the levels of pollution 
in different areas and allow people to make informed decisions about their 
outdoor activity and take action to reduce pollution levels.

 Ans 11. Upcycle means that a safe and eco-friendly alternative should be used in place 
of a non-biodegradable substance. Also, any product that is not usable can be 
upcycled with creativity and innovation. For example, using a cloth bag instead 
of a polythene bag.
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 Ans 12. A few green projects taken up in India for building a green economy include:
  (i) Digital Green aims at rural education, promoting education in rural areas 

through smart classrooms and video-based learning.
  (ii) Waste management and vermicomposting. Vermicomposting is a faster method 

for reducing organic waste than traditional composting. This approach utilizes 
the action of earthworms as well as bacteria to break down organic waste. 
The resultant material (vermicompost) can be a highly effective fertilizer or 
soil conditioner.

  (iii) Making solar energy accessible by providing customized solutions to industry 
clients.

  (iv) Banyan Nation is an initiative to work towards a pollution-free environment 
by collecting plastic waste from industries and recycling it for further use.

  (v) Bio toilet by Green Solution Foundation is an eco-friendly toilet. Its working is 
based on using aerobic bacteria. Its tank converts human waste into standard 
compatible water, which is used for flushing and even for irrigation.

 Ans 13. Green skills aim at developing a framework for building and managing a sustainable 
green economy. Learning green skills is an important and indispensable method 
to enhance knowledge, abilities, values and attributes to develop and support 
organizations that focus on saving the environment and improving it to support 
life systems.

  Some prominent areas in which green skills contribute to building a sustainable 
economy and improving environmental conditions are as follows:

 • Wastewater treatment
 • Using renewable energy (solar power and wind energy)
 • Rainwater harvesting
 • Green buildings and transportation
 • Use of clean energy and focusing on conserving energy
 • Reducing all types of pollution, mainly air, water and soil

  Building green economy can be achieved by inculcating green skills and environment-
friendly practices that require technical skills, knowledge, critical thinking and a 
problem-solving approach.



SUBJECT-SPECIFIC SKILLS

CHAPTER 1: Introduction to IT–ITeS Industry
Unsolved Questions
 Ans 1. Software Development is the process of developing, designing and implementing 

software to solve a particular problem.

 Ans 2. The significance of using ICT in teaching and learning is:
  (i) Classroom teaching has become more effective with smartboards and interactive 

whiteboards.
  (ii) Online tutorials, videos and lesson plans have contributed significantly to 

make the teaching-learning process interesting and enriching.
  (iii) Students can access any information through free and paid online educational 

services and portals like YouTube channels, online tutorials, apps, etc.
  (iv) Online assessments, exams, workshops and interactive sessions for the students 

can also be conducted conveniently.
  (v) With the implementation of information technology, the cost of accessing 

educational resources is very low. It also makes it easier for students to 
access these resources from anywhere.

  (vi) To manage school systems, many countries are using a software application 
called Learning Management System (LMS). It offers many services for both 
students and teachers. To access LMS, students and teachers can register 
themselves on its official website.

 Ans 3. The technological domains that provide opportunities within the IT industry are 
primarily based on three platforms:

  (i) Software or Application Development
  (ii) IT Application and Implementation
  (iii) Information Technology enabled Services (ITeS)

 Ans 4. The types of BPO services that are offered in India are:
  (i) Online Data Entry and Processing
  (ii) Maintaining Financial Ledgers and Accounting Books
  (iii) Telemarketing
  (iv) Call Centre
  (v) Transaction and Payment Processing
  (vi) Health and Healthcare
  (vii) Online Research and Data Analysis
  (viii) Customer Support
  (ix) Documentation

 Ans 5. IT organizations are classified based on the criteria or parameters given below:
  (i) The sector/area to which an organization is serving
  (ii) The type of service an organization provides
  (iii) The geographical span of an organization’s operations
  (iv) The scope and size of operations and profits generated
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 Ans 6. Examples of the uses of IT in schools are given below:
  (i) Learning Management System (LMS): Schools are using LMS platforms to 

manage and deliver online course content, assignments and assessments.
  (ii) Digital Classroom tools: Interactive whiteboards, projectors and educational 

software help in better understanding of concepts.
  (iii) E-books/Online resources: This makes learning more dynamic and up to date.
  (iv) Augmented Reality (AR), Virtual Reality (VR) and Robotics: These are the 

technologies that create interest and curiosity among children to learn and 
explore new concepts.

 Ans 7. Classification of the IT industry into various sectors:
  (i) Software Development
  (ii) Hardware Manufacturing
  (iii) Cloud Computing
  (iv) Information Technology
  (v) Telecommunications
  (vi) Artificial Intelligence (AI) and Machine Learning (ML)
  (vii) Data and Analytics

 Ans 8. Information Technology (IT) is extensively used in big malls and shopping outlets 
to enhance various aspects like operations, customer experience, security and 
management. There are several ways in which IT is applied in these environments, 
such as:

  (i) Barcode Scanning
  (ii) Dynamic Advertising
  (iii) Shopping and Mobile Payment apps
  (iv) Self-Service Kiosks

 Ans 9. There are the various processes in education where the use of IT is prominent:
  (i) Learning Management System (LMS)
  (ii) Online Education and E-learning
  (iii) Library Management System
  (iv) Student Information System (SIS)
  (v) Smart Class and Smartboards
  (vi) Digital Content Creation

 Ans 10. For digital communication, software tools and platforms like WhatsApp, Facebook, 
Email, Instagram, video conferencing, etc., are used, depending on the specific 
needs and preferences of users.

 Ans 11. GIC stands for Global In-house Centres. GIC organizations work for their parent 
organization only and not for external clients. However, GICs can be a part of 
MNCs or ISPs, for example, Deloitte in India, GE, American Express based in the 
US, etc.

 Ans 12. IT facilitates access to various services and technologies in our day-to-day lives. 
Some home computing activities supported by IT are described below:

  (i) World Wide Web (www) has made it simpler for us to do most of our tasks 
with a click of the mouse. We use online services to pay our electricity, gas 
and water bills, and to also pay income and property tax.

  (ii) We get online news through e-paper instantly and get continuously updated 
with notifications.
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  (iii) Wildlife documentaries, playing online games using smartphones and bingeing 
on web series have gained immense popularity because of the internet.

  (iv) We do online shopping of household goods and grocery such as milk, fruit, 
vegetables, etc.

 Ans 13. E-commerce platforms are online software applications or websites that facilitate 
buying and selling of goods and services over the internet. The various e-commerce 
platforms are listed below:

  (i) Amazon
  (ii) Flipkart
  (iii) Ajio
  (iv) Hopscotch
  (v) Myntra
  (vi) Lenskart

 Ans 14. The statement ‘Society and its functioning will come to a standstill without IT’ 
reflects the dependency of modern society on Information Technology (IT). In this 
modern era, we are highly dependent on IT tools; without IT, many sectors would 
be adversely affected. Some of these sectors are listed below:

  (i) Entertainment: The entertainment sector is heavily dependent on IT for 
content creation and streaming. Lack of IT would impact the availability of 
movies and music.

  (ii) Social Interaction: Social media and online platforms have become essential 
for networking and community-building. Lack of IT would limit people’s ability 
to connect and share information.

  (iii) Healthcare: Information technology has transformed healthcare with electronic 
diagnostic tools and health records. Without IT, medical professionals would 
face challenges in efficiently managing patients.

 Ans 15. Applications of IT in marketing are:
  (i) Digital Advertising and Marketing
  (ii) Customer Relationship Management (CRM)
  (iii) E-commerce platforms
  (iv) Customer Feedback and Surveys

 Ans 16. Since time immemorial, teaching and learning have been prevalent. Concepts 
and methodologies of teaching are changing in accordance with technological 
advancement. ICT contributes to effective teaching and learning in the following 
ways:

  (i) Smartboards and projectors: These interactive tools have replaced the earlier 
concept of teaching using chalk and blackboard. These technologies aid students 
in understanding the concepts by improving visualization.

  (ii) Online learning applications/contents: Online apps and contents allow 
students to learn beyond geographical limitations. Now, anyone can learn 
from anywhere.

  (iii) Augmented Reality (AR) and Virtual Reality (VR): The integration of AR and 
VR makes learning more interactive and engaging.



CHAPTER 2: Data Entry and Keyboarding Skills
Unsolved Questions
 Ans 1. The various types of keys present on a QWERTY computer keyboard are:
  (i) Alphabet Keys/Character Keys: These are 26 keys (A-Z) in total. They are 

used to type the alphabets.
  (ii) Numeric Keys/Number Keys: These are 10 keys (0-9) in total. They are used 

to type numbers.
  (iii) Punctuation Keys: Keys like comma (,), semicolon (;), full stop (.), etc., are called 

punctuation keys. These are used to correctly punctuate the written text.
  (iv) Special Keys: These keys are used to carry out special actions in the text 

editor. Examples: Spacebar key, Enter key, Escape key (Esc), Delete key and 
Backspace key.

  (v) Modifier Keys: These keys are used to modify the actions of another specific 
key for a temporary period. Examples: Shift keys, Symbol keys, Control key 
(Ctrl) and Alternate key (Alt).

  (vi) Function Keys: There are 13 Function Keys (F1-F12 and Fn key). Each of 
these has different functions.

  (vii) Navigation Keys/Arrow Keys: These keys are used to move the cursor left, 
right, up or down on a computer screen.

  (viii) Toggle Keys: These keys are designed for people with vision impairment. 
Examples: Num lock and Caps lock.

  (ix) System and GUI Keys: Windows key, print screen (PrtSc) and Break/Pause 
key are a few examples of it.

 Ans 2. Home Keys: Alphabets ASDF are home keys for the left hand while LKJ are home 
keys for the right hand. These are used to correctly position the fingers while typing.

  Guide Keys: F and J are called guide keys for both the left and the right hand. 
Both contain a raised tangible mark with the help of which a touch typist can 
place their fingers correctly on the home keys.

 Ans 3. Guide keys refer to keys on a keyboard on which a touch typist can correctly place 
their fingers.

  (a) Computer keyboard: F and J Space bar, Shift key, Arrow key and Enter key 
are called guide keys for computer keyboards.

  (b) Typewriter: A and semicolon (;) are the guide keys for typewriters.

 Ans 4. Typing ergonomics is important because of the following reasons:
  (i) It reduces muscle stress and fatigue.
  (ii) It prevents vision strain.
  (iii) It prevents postural issues.
  (iv) It offers long-term health benefits.

 Ans 5. The steps to download RapidTyping Software are given below:
  Step 1: On the web browser, type ‘Rapid Tutor Typing’ and search.
  Step 2: Open the first link of Rapid Tutor Typing.
  Step 3: Go to download section → download Rapid Tutor Typing (x32 or x64 as 

per device compatibility).
  Step 4: Run the downloaded file and follow the instruction provided by the software 

for installation.
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 Ans 6. The drag-and-drop feature of the mouse allows selecting and moving an object or 
file. To do so, place the mouse pointer on the required file or folder, hold down 
the left mouse button and drag the mouse to drag the file or folder (dragging) and 
release it (dropping) at the required location. The file or folder will be placed at 
the new location.

  Example: Move the desktop icons individually.

  To do so, consider the given steps:
  (i) Place the mouse pointer over the icon to be moved.
  (ii) Left-click the mouse and drag the icon to the new position.
  (iii) Now, let go of the mouse button.

 Ans 7. A typical mouse has two main buttons and a scroll wheel. Beneath the mouse, 
there is either a tracking ball or light beam to detect the motion of the mouse.

  The common mouse operations are:
  (i) Left-click: To select an item.
  (ii) Right-click: To display a set of commands.
  (iii) Double-click: To open files or folders.
  (iv) Drag and Drop: Allows selecting and moving an item from one location to 

another.
  (v) Scroll: To scroll up or down the page.
  (vi) Hover: Allows to read the tool-tip text on moving the mouse on certain 

websites.
  (vii) Blocking: To select word, lines or paragraph by just clicking and dragging.

 Ans 8. The three stages of Touch Typing are given below:
  Stage One: In this stage, the home row of the keyboard, beginning with the Caps 

Lock key, is memorized. It is strictly forbidden to look at the keyboard. This is 
accompanied by memorizing the number row, lower and upper rows, special symbols, 
and uppercase letters.

  Stage Two: In this stage, the frequently used syllables and the words containing 
these syllables are memorized.

  Stage Three: This stage requires enhancing the skills acquired by typing the actual 
text.

 Ans 9. The Error Overview tab shows all the correctly or incorrectly typed letters/characters. 
The correct keystrokes are displayed in green while the incorrect keystrokes are 
displayed in red. The exceeded timeframe for correct keystrokes is displayed in 
yellow while the exceeded timeframe for incorrect keystrokes is displayed in orange.

 Ans 10. (a) Lesson Control: It is a panel that contains various controls to enable and 
disable sound, adjust the volume and pause/resume the current lesson.

  (b) Steps to create/add a new course:
   Step 1: Click on Course menu → Create new course option.
   Step 2: Type the name of the new course that is to be added.
  (c) Virtual Keypad: It highlights the characters used in the selected lesson. 

Keyboard language relies on the course language, which can be selected in 
the Keyboard layout.



CHAPTER 3: Digital Documentation
Unsolved Questions
 Ans 1. LibreOffice Writer provides the following three views to work easily and conveniently 

with a document:
  (i) Normal View
  (ii) Web View
  (iii) Full Screen View

 Ans 2. The three features of a word processor are as follows:
  (i) It allows us to easily save a document and make modifications in an already 

created document.
  (ii) We can modify text by making it bold or italic, or by changing its color, size 

or style.
  (iii) Using a word processor, we can insert images, pictures, graphs, tables, etc., 

in a document.

 Ans 3. 
Copying Text Moving Text

(i) Copying text means duplicating text. (i) Moving text means moving it 
from the original position to a 
new position.

(ii) There is no change in the original 
position of the text.

(ii) The position of the original text 
changes to a new position.

(iii) Shortcut keys after selecting the text:
Ctrl+C and Ctrl+V.

(iii) Shortcut keys after selecting the 
text: Ctrl+X and Ctrl+V

 Ans 4. Match Case option in the Find and Replace dialog box searches results which only 
include instances where the case matches exactly, such as ‘kindness’ but not Kindness 
or KINDNESS.

 Ans 5. LibreOffice Writer supports the following six types of cases:
  Let us take the sentence “I am the best” as an example.
  (i) Sentence case: Displays the first letter in uppercase.
   “I am the best.”
  (ii) lowercase: Displays all the letters in lowercase.
   “i am the best.”
  (iii) UPPERCASE: Displays all the alphabets in uppercase.
   “I AM THE BEST.”
  (iv) Capitalize Every Word: Displays the first letter of every word in uppercase.
   “I Am The Best.”
  (v) tOGGLE cASE: Reverses the existing case.
   “i aM tHE bEST.”
  (vi) Cycle case: Displays the text in three different cases, following a cycle, such 

as Uppercase, lowercase and Sentence case.
   “I AM THE BEST.”
   “i am the best.”
   “I am the best.”

 Ans 6. The steps to insert line spacing and indentation in a paragraph are:
  Step 1: Start by selecting the desired paragraph.
  Step 2: Click Format → Paragraph; the Paragraph dialog box will appear.
  Step 3: In the Paragraph dialog box, select the Indents & Spacing tab.
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  Step 4: In the Indent section, set the indent. The indent options available are:
 • Before Text: This moves the text to the left side of the document. In the Indent 

section, specify the Before Text value.
 • After Text: This moves the text to the right side of the document. In the Indent 

section, specify the After Text value.
 • First Line: This moves the paragraph’s first line to the right.
  Step 5: Select the required line spacing from the Line spacing list box.
  Step 6: Click OK.

 Ans 7. Follow the given steps to create a numbered list in LibreOffice Writer document:
  Step 1: Select the text or paragraph where you have to apply numbers. If the text 

has not been typed yet, position the cursor at the place in the document from where 
the text will commence.

  Step 2: Click on Format → Bullets and Numbering option. This will display the 
Bullets and Numbering dialog box.

  Step 3: The Unordered tab is selected by default. Select the desired numbering 
style by clicking the Ordered tab.

  Step 4: Click OK. In the document, the required numbering style will appear.

 Ans 8. You can add a word in Writer’s standard dictionary by clicking Tools → Options 
→ Languages and Locals → Writing Aids. Under User-defined Dictionaries, 
select the standard [All] checkbox and then click on New button. The New Dictionary 
dialog box appears, enter a word you want to add in a dictionary and click OK. 
Then click on Apply button.

 Ans 9. The steps for creating data source for using the Mail Merge feature in Writer are:

  Step 1: Select File → Wizards → Address Data Source in the Writer document 
window. This will display the Address Book Data Source Wizard dialog box.

  Step 2: Select Other external data source radio button from the Address Book 
Data Source Wizard dialog box and on Next.

  Step 3: Click on Settings in the next page of the wizard.

  Step 4: Choose the Database type in the Create Address Data Source window. 
Click on Next.

  Step 5: Click Browse to select the spreadsheet file to be used as data source. Then, 
click Finish.

  Step 6: Click on Next in the following page that opens. Be mindful of not clicking 
Field Assignment since this is a spreadsheet.

  Step 7: Once a database file is created, you need to give a name to this file in the 
Location field. Although Addresses.odb is the default file name, you may change 
it with a new name of your choice. The registered file name, which LibreOffice will 
display in data source listings, is the name in this field.

  Step 8: The data source will get registered once you click the Finish button.

 Ans 10. 
Superscript Subscript

(i) The tool is used to place the 
selected text just above the normal 
line of text.

(i) The tool is used to place the 
selected text just below the normal 
line of text.

(ii) Shortcut for applying Superscript:
Ctrl+Shift+P.

(ii) Shortcut for applying Subscript:
Ctrl+Shift+B.
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 Ans 11. The four types of paragraph alignments in LibreOffice Writer are—Left, Center, 
Right and Justified.

 Ans 12. Applying and modifying font style, type, size, color and other text attributes, i.e., 
bold, italic, underline, etc., to the individual characters or set of characters is called 
Character Formatting.

 Ans 13. Header: Header refers to the information at the beginning of the page that gives 
additional details about the page. It is at the top of a page in an electronic document 
or hard copy. For example, the headings of a topic.

  Footer: It also provides additional information about the page. It is at the bottom 
of the page in an electronic document or hard copy. For example, the page number 
at the bottom of the page.

 Ans 14. In LibreOffice Writer, paragraph spacing refers to the space before and after 
paragraphs. It improves readability and organization in a Writer document. We 
can specify the amount of space we want before and after each paragraph, in cms. 
This feature provides better control over the document’s layout, helping to clearly 
differentiate between sections and improving the overall presentation of a document. 
We can make changes in the paragraph spacing by clicking Format menu and select 
Paragraph option.



CHAPTER 4: Electronic Spreadsheet
Unsolved Questions
 Ans 1. Significance of using the spreadsheet software is given below:
  (i) It tabulates data to arrange it in an organized manner.
  (ii) It adds or deletes multiple sheets as and when required.
  (iii) It applies formulas and functions to perform automatic calculations with 

respect to changing data or figures.
  (iv) It works and arranges data in either ascending or descending order through 

sorting or other tools such as filters and macros.
  (v) It represents data pictorially in the form of graphs and charts.
  (vi) It filters the required data.
  (vii) It checks the validity of data to ascertain if it is correct or not.
  (viii) It uses passwords to provide data protection.
  (ix) It maintains, stores and saves data and records overtime for future use.

 Ans 2. By default, LibreOffice Calc has one worksheet.
  To insert a new worksheet, follow the given steps:
  Step 1: Right-click on the current sheet tab which is displayed at the bottom of 

the spreadsheet window.
  Step 2: Choose Insert Sheet option.

OR

  Click on + symbol (Add new sheet). The new worksheet gets added in the workbook.
  The steps to rename the inserted new worksheet are:
  Step 1: Right-click on the newly added worksheet and select Rename Sheet option.
  Step 2: The Rename Sheet dialog box appears. Enter the desired name. Click 

OK.

 Ans 3. Follow the given steps to rename a worksheet in Calc:
  Step 1: Select the worksheet by clicking it from Sheet tab which is displayed at 

the bottom of the spreadsheet.
  Step 2: Right-click on it and choose Rename Sheet.
  Step 3: The Rename Sheet dialog box appears. Enter the desired name. Click 

OK.
OR

  Step 1: Double-click on the current sheet tab and rename it.
  Step 2: The Rename Sheet dialog box appears. Enter the desired name. Click 

OK.

 Ans 4. The required steps are:
  Step 1: Right-click on the current sheet tab present at the bottom of the spreadsheet 

window.
  Step 2: Choose the option Insert Sheet for inserting a new worksheet. Choose 

Delete Sheet to delete the existing sheet.

 Ans 5. The currently selected cell, highlighted with a thick, blue border around it, is 
called an Active Cell. Whatever data (numbers, text, formulas, etc.) is entered, it 
will be displayed in the active cell only.

  Pressing the delete key or backspace key will delete the content of the active cell.
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 Ans 6. 
Relative Cell Address Absolute Cell Address

(i) It is the default cell referencing. 
It keeps on changing. That is 
why if the formula we move or 
copy to another cell in relative 
cell referencing, the cell addresses 
will be changed accordingly in the 
formula.

(i) Once the cell address is made 
absolute, it will remain constant 
or unchanged even if the formula 
is moved or copied to another cell; 
the cell address in that formula will 
not change or formula containing 
the absolute cell address is dragged 
to the other rows and columns in 
the worksheet.

(ii) It does not use any symbol. (ii) It uses ‘$’ symbol for both column 
name and row number.

(iii) Example: If a formula is ‘=A1*B1’ 
in cell C1 and copied to cell C2, 
the formula will be adjusted to 
‘=A2*B2’.

(iii) Example: If a formula is ‘=$A$1                                      
*$B$1’ in cell D1 and copied to cell 
D2, the formula will still refer to 
cells A1 & B1.

 Ans 7. The two operations that can be performed on spreadsheet data are:
  (i) Addition ( + )
   Example: =12+5 will give 17 as the output.
  (ii) Subtraction ( – )
   Example: =12 – 5 will produce 7 as the output.

 Ans 8. While writing formulas, be mindful of the following rules:
  (i) An equal to (=) sign must be used in the beginning of a formula.
  (ii) There must be some operator(s) to perform mathematical calculations on the 

data.
  (iii) The data (usually a value) is handled and manipulated using cell addresses 

or a range of cells.
  (iv) After entering the formula, press the Enter key so that the same cell will 

display the result.
  (v) Press the F2 function key from the keyboard if you wish to edit the formula 

or data that you have entered. Formulas can also be edited using the Input 
line in the Formula bar.

 Ans 9. Yes, a formula in spreadsheet can have more than one mathematical operator.

 Ans 10. The steps to be followed to make the required toolbar visible in a LibreOffice Calc 
spreadsheet are:

  Step 1: Open the spreadsheet on which you wish to work.
  Step 2: Click on View menu and then select Toolbars option.
  Step 3: A sub-menu appears with various toolbars options.
  Step 4: Select the desired toolbar option such as Standard, Formatting, etc.

 Ans 11. (i) =SUM(value1;value2;value3;…..;value n): This function is used for calculating 
the total of the entered numbers or cell range.

   For example: =SUM(10;20;30) will produce output as 60.
  (ii) =AVERAGE(value1;value2;…..;value n): This function is used for calculating 

the average of the entered numbers or cell range.
   For example: =AVERAGE(10;20;30) will produce output as 20.
  (iii) =MAX(value1;value2;…..;value n): This function is used for finding the 

maximum/largest values from the entered numbers or cell range.
   For example: =MAX(10;20;30) will produce output as 30.



Book-IX 33

 Ans 12. The steps to be followed to create a new spreadsheet:
  Step 1: Click File menu → New.
  Step 2: From the submenu that opens, click on Spreadsheet. Alternatively, from 

the Standard toolbar, you may click on the New shortcut button.
  Step 3: A new sheet named Untitled 1 shall be opened on the screen, ready for 

data entry with A1 as the active cell.
OR

  Alternatively, the shortcut key to create a new spreadsheet is Ctrl + N.

 Ans 13. Chart in Calc offers the following advantages:
  (i) It represents data in a format that is easy to understand. One can easily 

interpret and analyze data by simply looking at the chart.
  (ii) It helps in summarizing data values and their relation with each other.
  (iii) It helps in a better analysis and comparison of data, which is useful in business 

forecasts, predictions, decision-making and in accessing the prevalent trends.
  (iv) It helps forecast trends based on the comparisons done.

 Ans 14. Following are the types of charts in Calc:
  (i) Line Chart: In line chart, data is plotted in the form of a line with connecting 

dots. It offers a standard line graph which is useful for displaying the changing 
data over time. Along the horizontal axis, it displays categories and along 
the vertical axis, it displays values.

  (ii) Column Chart: This type of chart is the most suitable chart for small data 
sets and represents data over a given period in the form of vertical columns. 
Along the horizontal axis, it displays categories and along the vertical axis, it 
showcases values. Column chart is the default chart type. It allows comparing 
a single category of data between two or more items.

  (iii) Bar Chart: Bar chart displays data in the form of horizontal columns or bars. 
Along the vertical axis, it presents categories and along the horizontal axis, 
it shows values.

  (iv) Pie Chart: It is the most suitable chart that is used for representing data 
or value of each item in proportion or percentage to the consolidated or the 
sum value of all the items. A circular plot dissected into slices for showing 
numerical proportions is known as a pie plot. A slice of any object we are 
referring to or time is presented by pie charts. A specialized graph used in 
statistics, a pie chart/graph displays only one series of data. The independent 
variable is plotted around the circle.

  (v) X-Y (Scatter) Chart: The X-Y (Scatter) chart depicts the relationships among 
the numeric values of two data series. This chart displays and combines 
uneven intervals or data points from X and Y axes. It is commonly used to 
represent scientific data.

  (vi) Area Chart: Data is evinced in the form of an area in this type of chart. It 
is used to depict the volume of the changes of data over time. As compared 
to line charts, area charts provide a better visual impact.

 Ans 15. For inserting a chart in Calc, follow the given steps:
  Step 1: Click the Insert menu → select Chart option. The Chart Wizard dialog 

box shall be displayed.
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  Step 2: Select the desired Chart Type and Shape, and click Next. By default, 
the chart type is Column chart.

  Step 3: Click on the Data Range field under the heading Choose a Data Range 
and select the desired Data Range. Select either of the options—Data series in 
rows or Data series in columns. Click Next.

  Step 4: Give the cell range to be taken for Data Range for X-axis and Y-axis, 
respectively.

  Step 5: Click Next.
  Step 6: Give suitable Titles, Legend and Grid Settings for the Chart. Click Finish.

 Ans 16. The five components of a chart in spreadsheet Calc are:
  (i) Chart Title: It defines the appropriate heading/title given to a chart that 

helps identify the said chart.
  (ii) Chart Area: It is the total area including the entire chart and its elements.
  (iii) Data Series: It defines the set of values in a chart that need to be plotted.
  (iv) Axes (X-axis and Y-axis): There are two axes in a chart—X-axis and Y-axis. 

X-axis is defined as the category axis. It is the horizontal axis that usually 
represents the names of any category or entity.

   Y-axis is defined as the value axis. It is the vertical axis of the chart that 
represents data series or sequence of values.

  (v) Plot Area: Bounded by the axes, this is the area of the chart where data is 
plotted.



CHAPTER 5: Digital Presentation
Unsolved Questions
 Ans 1. The three presentation software are LibreOffice Impress, Microsoft PowerPoint, 

OpenOffice Impress and Google Slides.

 Ans 2. The following ways are used to create an empty presentation using LibreOffice 
Impress:

  Open Impress Presentation and the screen (Select a Template) appears with a 
blank presentation slide.

OR

  Click File menu → New → select Presentation.

OR

  The shortcut key combination to create an empty presentation is Ctrl+N.

 Ans 3.  
Notes View Handouts View

(i) This view is used to add and display 
speaker notes for each slide.

(i) This view is used to view and 
organize slides in a thumbnail grid.

(ii)  It displays one slide with a notes 
section below it.

(ii) It shows all slides in miniature, in 
a grid format.

(iii) Notes are visible only to the 
presenter during a presentation.

(iii) All slides are visible at once but 
not in detail.

(iv) It is helpful for presenters to 
prepare notes for each slide.

(iv) It is useful for managing the 
sequence and organization of slides.

 Ans 4. The steps to insert a video in LibreOffice Impress are given below:
  Step 1: Click on the slide in which you wish to insert a video.
  Step 2: Click on Insert menu → Audio or Video.
  Step 3: The Insert Audio or Video dialog box appears.
  Step 4: Then select the video that is required to be inserted in a slide.
  Step 5: Finally, click Open.

 Ans 5. Slide Transition refers to the effects that are applied on the slides and are seen 
when one slide changes to the next slide in a presentation during a slide show 
whereas animation refers to the special effects that are applied to individual items 
on a slide such as text, shape, image, etc.

 Ans 6. Consider the following steps to add transition effects to all the slides in a presentation:
  Step 1: Click the slide on which you wish to apply the transition effect.
  Step 2: On the extreme right of the Impress interface, click the Slide Transition 

button. This displays the Slide Transition docking tasks pane.
  Step 3: From the Slide Transition list box, select the desired transition effect such 

as Wipe, Checkers, etc.
  Step 4: Once you apply the selected transition effect, certain properties get activated 

under two sections—Modify Transition and Advance Slide.
  Step 5: In the Modify Transition section, select the desired Variant and Duration 

of transition.
  Step 6: If required, select the Sound alert that has to be played during the selected 

transition in the same section.
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  Step 7: The On mouse click option is selected by default in the Advance Slide 
section. Select the After radio button and specify the time for transition in seconds 
if you wish the slide transition to take place automatically.

  Step 8: To apply transition to all the slides, click on Apply Transition to All Slides 
button.

  Step 9: To preview the transition effect, click on the Play button.
  Step 10: To start the slide show from the current slide, click on the Start from 

First Slide button to view the presentation in full screen.

 Ans 7. An effective presentation possesses the following salient characteristics:
  (i) A presentation should be relevant and should adhere to the purpose and 

agenda for which it has been created.
  (ii) Effectiveness of a presentation relies on the command over the language 

being used. Thus, good communication skills, interpersonal skills and good 
command over the subject are of utmost importance.

  (iii) To engage the audience, the contents of the presentation should be eye-
catching and effective, especially the opening or the introduction part of the 
presentation. This can be achieved by adding more images, precise text, short 
video clips and questions related to the content.

  (iv) The flow of the presentation, in terms of subtopics and their subheadings, 
should be proper and should carry the message that needs to be conveyed to 
the audience with clarity.

  (v) The content should be short and concise, preferably in the form of bullet 
points.

  (vi) More images, charts and infographics (graphical summary) should be added 
since they improve understanding and help while briefing the slide contents.

  (vii) A good presentation should have a well-defined beginning, brief body and an 
appropriate ending.

  (viii) The content of the presentation should make use of positive notions and avoid 
the use of negative phrases and words like do not, cannot, should not, etc.

  (ix) Overall, a presentation should be complete in terms of the required information, 
format and timings. Also, the presenter should anticipate possible questions. 
The presentation should not be under or overloaded with information and 
should include the element of audience involvement and interaction.

 Ans 8. In LibreOffice Impress, the Master Slide is the most powerful tool. It helps to 
define and set the default look of slides in a presentation in terms of background 
color, images, styles, text formatting effects, etc. Once we make changes in the 
Master Slide, these changes will be automatically reflected in all the slides of the 
presentation.

 Ans 9. We can create a new presentation in two ways—either an empty presentation or 
by using a template.

  Here, we are creating  a presentation using Template.
  Step 1: Open the LibreOffice Impress. It will display Select a Template window 

for creating a presentation using Impress templates.
  Step 2: Select the template from the All Categories drop-down list.
  Step 3: Then click on Open button.
  Step 4: The new presentation will be opened with a few slides; selected template 

is applied to them.
  Step 5: We can also modify them and add new slides to work with.
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  For running a slide show from the start (Start from First Slide), press the F5 key.

OR

  You can also click on Slide Show menu → Start from First Slide option. Press 
Escape (Esc) key to exit the slide show.

 Ans 10. Slide Sorter View is used to view more than one slide in a small slide, termed as 
miniature slides or thumbnails, on the screen. The slide number appears at the top 
towards the left corner of each slide. This view helps in resetting or redefining the 
order of slides. In this view, the sequence of the slides can be cut, copied, pasted 
or even changed.

 Ans 11. Follow the steps given below for inserting a table in a LibreOffice Impress slide:

  Step 1: Click on Insert menu → Table option. This displays the Insert Table 
dialog box; now, enter the required number of columns and rows.

  Step 2: Click the OK button. A table shall be inserted at the desired location on 
the currently selected slide.

OR

  On the Standard toolbar, click the Table button to insert a table.

 Ans 12. Special effects applied to different elements of a presentation such as text, pictures, 
tables, shapes or any other object in a slide are called custom animation.

  Different animation effects of the custom animation available in LibreOffice Impress 
are:

  (i) Entrance Animation Effect
  (ii) Emphasis Animation Effect
  (iii) Exit Animation Effect
  (iv) Motion Paths Animation Effect
  (v) Misc Effect


